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Bienvenue 
 
Nous vous remercions de l‟intérêt que vous portez à notre Concept Graphique CLAIRITEC ! 
En faisant l‟acquisition de nos cartes graphiques intelligentes, vous bénéficiez gratuitement d‟un 
service complet d‟aide au développement de votre IHM, dont GraphConverter 2.0 en est un des 
modules. Pour plus de détails sur le Concept Graphique CLAIRITEC, visitez notre site Internet 
dédié, à l‟adresse : www.clairitek.com  
 
 

 
Toutes les informations contenues dans ce manuel étaient correctes au moment de sa publication. 
Toutefois, dans la mesure où nous améliorons et mettons fréquemment à jour nos produits, le logiciel 
peut présenter des différences mineures d’apparence ou de fonctionnalités par rapport aux indications 
figurant dans ce manuel. 
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Chapitre 1 : GraphConverter 2.0  
 

1. Présentation générale du logiciel 
 

GraphConverter 2.0 est un logiciel de création de chartes graphiques de polices de caractères et 
d‟images, téléchargeables dans la mémoire interne des cartes graphiques CLAIRITEC. La charte est 
créée à partir des polices et des images présentes sur votre poste de travail Windows®. 
 
En quelques clics de souris vous composez votre charte en sélectionnant dans votre système, les 
polices et images que vous souhaitez voir affichées sur votre afficheur LCD. 
 
Les polices sont encodées par GraphConverter 2.0 pour être compatible avec les cartes graphiques 
CLAIRITEC. Les fichiers de polices sont obligatoirement des fichiers de type TrueType (.TTF). 
 
Les fichiers images sont obligatoirement des fichiers de type Bitmap (.BMP). 
 
NB : Dans cette version, l’anglais est la seule langue disponible. 

 
2. Principales améliorations depuis la version 1.92 

 

Parmi les changements majeurs attendus, on peut noter la restructuration du code qui rend le logiciel 
plus facile à maintenir, améliorer et distribuer, des améliorations de l‟interface graphique et de 
l‟ergonomie et de nouvelles fonctionnalités :   
 

 Restructuration du code : Portage sur la plate-forme.NET, compatibilité avec le Framework 
3.5 SP1 :  

 Adaptation du code au nouveau design (utilisation de la technologie WPF de 
Microsoft), 

 Gain de performance au niveau des ressources utilisées, 
 Pas de gestion de la base des registres, 

 

 Nouveau design de l’interface graphique et nouvelle ergonomie : Accélération de la 
réalisation des projets : 

 Nouvel habillage graphique, look plus actuel, 
 Création et configuration d‟un nouveau projet « étape par étape », 
 Boutons pour les actions courantes « Save », « Test » et « Upload », 
 Nombreuses info-bulles. 

 

 Nouvelles fonctionnalités :  
 Edition des images : possibilité d‟insérer, de modifier ou de supprimer une image 

dans le projet, 
 Edition des polices :  

 plus besoin de spécifier les caractères sélectionnés d‟une police : les 255 
caractères sont automatiquement enregistrés, 

 Amélioration du codage des polices : spécification de la propriété « Interval » 
qui permet de régler le nombre de pixels entre deux caractères d‟un mot au 
moment de leur affichage, 

 Génération d‟un fichier header (extension .h), 
 Nouvelle gestion des projets avec création à la compilation d‟un dossier « Projet » 

contenant l‟ensemble des fichiers et des données constituant la charte graphique 
(Consulter « Chapitre 3 : Gestion de projet »). 

 
 

3. GraphConverter 2.0 et les cartes graphiques CLAIRITEC 
  
Les cartes couleurs sont destinées à recevoir des chartes graphiques de capacité mémoire 
importante, (jusqu‟à 64Mo). 
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Votre logiciel GraphConverter 2.0 est compatible avec tous les modèles de cartes graphiques 
CLAIRITEC. Mais pour cela, il doit connaître les caractéristiques de celles-ci, taille maximale 
d‟images, profondeur de couleurs, taille maximale de la mémoire interne, le type d‟afficheur utilisé, 
(TFT, STN, QVGA, VGA), etc.… 
 
Ces informations sont contenues dans des fichiers « pilotes » dont les plus standards sont installés 
par défaut avec GraphConverter 2.0 et certaines sont paramétrables dans GraphConverter 2.0. 
 

Dans le cas d‟afficheur spécifique non standard à CLAIRITEC, ou nouveau, il sera peut-être 
nécessaire d‟installer un pilote particulier. (Consultez le site www.clairitek.com pour connaître les 
afficheurs « standards CLAIRITEC », contactez le support CLAIRITEC pour avoir des informations sur 
des afficheurs spécifiques). 

 
(Consultez le chapitre « Chapitre 2 : Installer GraphConverter 2.0 » pour plus d’informations sur les 
fichiers pilotes.) 
 

 

Chapitre 2 : Installer GraphConverter 2.0   
 

1. Configuration de votre système 
 
Configuration minimale requise :  

 Céléron, ou K6 200 MHz,  

 32Mo de Ram,  

 Ecran VGA 256 couleurs résolution 800x600 pixels. 
 
Configuration souhaitée :  

 Pentium III ou Athlon 1.2GHz,  

 128 Mo de Ram,  

 Ecran SVGA millions de couleurs. 
 

Système d‟exploitation :  

 Microsoft Windows Server 2003, 

 Windows XP Professionnel,  

 Windows 2000 Professionnel (Service Pack 3 ou version ultérieure requis), 

 Windows 2000 Server (Service Pack 3 ou version ultérieure requis), 

 Windows NT 4.0 (VSNET 2002 exclu).  
 

 
L'installation du Framework 3.5 SP1 de Microsoft est indispensable sur le poste cible !  

(Téléchargeable gratuitement sur le site www.microsoft.com ) 
 

 

2. Configuration des répertoires 
 

Si vous avez installé une version antérieure, il est conseillé de la désinstaller en utilisant le 
programme « Ajout/Suppression de programmes » du gestionnaire de Programmes de Windows, ou 
en cliquant sur « Désinstaller GraphConverter 2.0 » dans le menu « Démarrer » du logiciel. 

 

 
A l‟installation, GraphConverter2.0 crée deux dossiers pour accueillir deux types de fichiers. 

 Les fichiers « programme » : les fichiers programme sont toujours installés 
localement sur chaque poste de travail. 

 Les fichiers « données » : il s‟agit des fichiers .gxp et .hex des projets. 
 
 

http://www.clairitek.com/
http://www.microsoft.com/
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Avant de procéder à l‟installation, vous devez décider dans quel dossier installer le programme, car 
vous ne pourrez pas changer de dossier ultérieurement, sauf à désinstaller et à réinstaller le 
programme. 
 
Nous vous conseillons de choisir deux dossiers différents pour les fichiers de données et les fichiers 
« programme ». Ceci vous permet de séparer les données nécessitant une sauvegarde des autres. La 
figure ci-dessous présente la définition des dossiers proposée par défaut à l‟installation (Installation 
standard) : 
 

 

 
 
 

Dans ce manuel, on supposera le programme installé dans le dossier proposé par défaut à 
l‟installation : C : \Program Files\Clairitec 

 
 
L‟installation du logiciel est tout à fait classique. A chaque étape, vous pouvez laissez les options par 
défaut sans aucun risque. 
 
Changer les dossiers et options d‟installation n‟est utile que si votre installation de Windows est 
particulière (disques systèmes en réseau, profils administrateurs…). 
 

3. Installation depuis le fichier compressé « InstallGraphConverter2.zip » 
 

1. Décompressez le fichier à l‟aide de WinZip, par exemple, 
2. Depuis l‟explorateur de fichiers de Windows, cliquez deux fois sur le fichier 

décompressé «InstallGraphConverter2.exe», 
3. Suivez les instructions. 

 

4. Installation depuis le CD-Rom ou la clé USB 
 

1. Cliquez sur le fichier «InstallGraphConverter2.exe» présent dans le dossier : 
GraphConverter 2.0 \ GraphConverter2_Install, 

2. Suivez les instructions. 
 

5. Installation des fichiers « pilotes » des cartes graphiques 
 
GraphConverter 2.0 est livrée avec les fichiers pilotes des cartes graphiques les plus utilisées. Ces 
fichiers sont copiés dans le dossier « LibraryCard » créé à l‟installation du logiciel dans le répertoire 
de l‟exécutable (Par défaut : C:\Program Files\Clairitec) 
 

 

 
 

 

6. Installation du câble adaptateur USBRS232 FTDI US232R 
 
GraphConverter 2.0 s‟interface avec le port série de la carte graphique via le port USB de votre 
ordinateur. Ceci permet d‟effectuer des téléchargements de gros fichiers à des vitesses supérieures à 
115KBds. 
 
La version CD-Rom de GraphConverter 2.0 est également livrée avec les pilotes du câble US232R 
mais nous vous conseillons de vérifier les dernières mises à jour sur le site www.ftdichip.com.  Pour 
installer le driver suivez les instructions indiquées sur la documentation FTDI « guide d‟installation  

http://www.ftdichip.com/
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Chapitre 3 : Gestion de projet   
 
Lorsque vous créez une charte graphique avec GraphConverter 2.0, vous travaillez dans le contexte 
d‟un « projet ».  
 
Un projet est l‟ensemble des fichiers et des données nécessaires pour construire votre charte 
graphique. Il est composé d‟un fichier de données (extension .gxp), d‟un fichier de données compilées 
(extension .hex), d‟un fichier d‟entête, (extension .h), pour votre applicatif en langage C, qui sont 
générés à la sauvegarde de votre projet, ainsi que d‟un dossier « Pictures » dans lequel est 
sauvegardé l‟ensemble des images composant votre charte graphique.  
 

Par défaut, le répertoire de compilation et de sauvegarde des fichiers générés par GraphConverter 2.0 
est : D:\Mes Documents\MyGraphConverter\NomDuProjet 

 

 
 

 Le fichier .gxp 
 

Le fichier (.gxp) est le fichier que vous ouvrez avec GraphConverter 2.0. Il contient deux groupes 
principaux composés des polices et des images dont vous avez besoin pour créer votre IHM. 
Chaque objet (polices ou images) est défini dans le projet par un numéro (qui sera son numéro 
d‟emplacement dans la « zone mémoire » de la carte graphique) et par son nom, (nom système pour 
les polices, nom de fichier pour les images). (Consultez la documentation de votre carte graphique 
pour plus de détails sur l’organisation des polices et des images dans la mémoire interne allouée à la 
charte) 
 

 Le fichier .hex 
 

Le fichier de données (.hex) contient les données codées de la charte complète qui seront 
téléchargées et programmées dans la mémoire flash de la carte graphique CLAIRITEC.  
 

 Le fichier .h 
 

Le fichier d‟entête (.h) est à inclure dans votre code applicatif en langage C.  
Il défini le nom des polices et des images que vous avez inséré dans votre bibliothèque graphique et y 
fait correspondre le numéro attribué par GraphConverter.  
Ce numéro est utilisé dans les commandes Escape émises à la carte graphique pour l‟affichage des 
textes ou des images. 
 
Ceci vous permet une maintenance aisée de votre code, en cas de changement de place des objets 
graphiques dans votre charte. 
 

 Le dossier « Pictures » 
Pendant la compilation et la sauvegarde, GraphConverter 2.0 sauvegarde également l‟ensemble des 
images de votre projet dans un dossier « Pictures » créé dans le répertoire de votre projet. 
 

Par exemple, si vous avez conservé les paramètres par défaut, les images sont sauvegardées dans le 
dossier : C:\Mes Documents\MyGraphConverter\NomDuProjet\Pictures 
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Ce système vous permet de créer autant de chartes que vous le désirez et de les maintenir à jour en 
fonction de l‟évolution de votre application. Vous pouvez également copier ou déplacer le répertoire 
de votre projet vers n‟importe quel emplacement sur votre poste ou sur un autre poste. 
 
(Consultez le chapitre « Chapitre 7 : Enregistrer le projet» pour plus d’informations sur les fichiers 
générés.) 
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Chapitre 4 : Créer un nouveau projet 
 

Vous pouvez lancer l‟application des manières suivantes : 
 

1. Menu Démarrer →Tous les programmes →Clairitec → GraphConverter2.exe ou  

2. Double-clique sur l‟icône  installée sur votre bureau. 
 
Au démarrage de l‟application, la fenêtre suivante est affichée :  
 

 
 
 
Cette fenêtre permet de créer un nouveau projet, d‟ouvrir un projet existant ou d‟en sélectionner un 
dans la liste des projets récemment ouverts.  

1. Cliquez sur « New Project ». 
 

1. Configuration du projet : Paramètres généraux 
 
En cliquant sur « New Project » au démarrage de GraphConverter 2.0 ou sur File → New Project 
depuis la barre de menu du logiciel, la fenêtre « New Project Parameters » s‟ouvre : 
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Cette fenêtre va vous permettre de nommer votre projet, de sélectionner la carte et l‟afficheur choisis 
et de configurer leurs paramètres. 
 

 Project Name : Rentrez votre nom de projet. Par défaut, « Project1 » (Si « Project1 » 
existe, « Project2 », …). A la sauvegarde, les fichiers « NomDuProjet.gxp » et 
« NomDuProjet.hex » seront créés dans D:\Mes Documents\MyGraphConverter. 

 

2. Sélectionnez la carte 
 

 Select Card :  
1. Cliquez sur la flèche du menu déroulant pour afficher la liste des pilotes des 

différentes cartes CLAIRITEC et de leur mode de communication (RS232, CAN) 
installés avec l‟application.  

2. Sélectionnez votre modèle dans la liste. 
 

 Select Memory Size : Configure les paramètres de la taille mémoire de votre carte 
graphique. En effet pour un pilote de carte graphique, vous pouvez avoir 5 modèles de 
mémoire (4Mo, 8Mo, 16Mo, 32Mo, et 64Mo). 

 

 
 

Ce paramètre est utilisé ensuite lors de la sélection des polices et des images pour votre 
projet : tout au long de vos sélections, une jauge vous informe en temps réel de la quantité de 
mémoire utilisée par votre charte.  
Si la taille calculée dépasse la capacité mémoire allouée par la carte graphique, un message 
d‟erreur vous en informe, et GraphConverter 2.0 n‟intègrera pas le nouvel objet sélectionné. 
(NB : 16Mo sont implémentés en standard sur nos Starters Kits).  

 

3. Sélectionnez l’afficheur 
 

 LCD Parameters : en fonction du choix du modèle de carte, une liste d‟afficheurs 
compatibles est disponible. 

 

 
 

 Select LCD Configuration : Une fois que vous avez sélectionné votre afficheur, ses 
paramètres par défaut sont affichés dans les différents contrôles. 
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 Left/Right et Up/Down :  
 

 
 

Ces deux paramètres permettent à la carte graphique de configurer les deux lignes de commandes de 
même nom et d‟inverser ainsi le sens d‟affichage GaucheDroite et/ou HautBas du LCD.  
Le paramètre par défaut (0 ou 1) dépend de l‟afficheur sélectionné. 
(La disponibilité des lignes L/R et U/D sur ses connexions dépend de l’afficheur sélectionné. En cas 
de non disponibilité, ces paramètres sont désactivés). 
 

 Orientation :  
 

     
 
Ce paramètre vous permet de modifier le mode d‟affichage « natif » de votre écran. Ce paramètre, 
(Landscape ou Portrait), dépend de l‟afficheur sélectionné. 
Avec ce paramètre, la carte prendra en charge une rotation à 90° de l‟affichage des polices de 
caractères. (Attention, les images continuent de s‟afficher dans le sens natif de l‟écran). Consultez la 
note d‟application « Méthode de rotation d‟affichage Paysage ou Portrait » pour plus de détails. 
 

 Backlight :  
Ce paramètre vous permet d‟indiquer à la carte graphique le niveau actif de la commande de 
backlight. Le paramètre par défaut (0 ou 1) dépend de l‟afficheur sélectionné et de son rétro-éclairage. 

 

 TouchScreen Configuration :  

 Integrated : dalle tactile « 4 fils » généralement intégrée à l‟afficheur. 

 Fujitsu : une carte Fujitsu interface les dalles type « 7 fils » et la carte graphique. 
 

 
 

4. Configurez les paramètres de communications 
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 Mode RS232 : Le choix de la carte graphique en mode RS232 impliquera l‟affichage de 
l‟onglet « RS232 ».  

 
 

 Speed Parameters : paramétrage de la vitesse de communication entre la carte et ses 
différents périphériques (PC, votre applicatif). 9 vitesses sont configurables : de 9600 
bauds à 530 000 bauds.  

Sur les cartes graphiques CLAIRITEC, le port « Uart0 » est dédié à l‟interface avec votre PC pour le 
téléchargement de la charte graphique ou du firmware via GraphConverter 2.0. Les niveaux 
électroniques sont standards RS232. 
Le port « Uart1 » est dédié à l‟interface avec votre application, les niveaux électroniques sont 
standards TTL.  

 
NB : Vous pouvez régler indépendamment les vitesses des 2 ports séries de votre carte graphique. 
 

 Mode CAN 
 

 
 

 Speed CAN : Paramétrage de la vitesse de communication. Trois vitesses sont 
configurables : 100KBds, 250KBds et 500KBds. 

 

 Frames Emission  

 ID frames commands : Permet de régler l‟identifiant des trames de commandes 
d‟affichage. L‟ID est de type standard 11bits, la valeur à saisir est en 
Hexadécimal, (base 16). 

 

 Frames (Réception)  
 

 ID frames lecture registers : Permet de régler l‟identifiant des trames de lecture 
des registres d‟état ou de la dalle tactile. L‟ID est de type standard 11bits, la 
valeur à saisir est en Hexadécimal, (base 16). 

 

 ID Lecture ID+Options : Permet de régler l‟identifiant de la trame de 
« reconnaissance » des paramètres CAN déjà programmés dans la carte 
graphique. L‟ID est de type standard 11bits, la valeur à saisir est en Hexadécimal, 
(base 16). 
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 Speed Uart0 : paramétrage de la vitesse de communication entre la carte et votre 
PC pour le téléchargement de la charte graphique. 9 vitesses sont configurables : 
de 9600 bauds à 530 000 bauds. 

 
 

Les paramètres généraux et les paramètres de communication seront téléchargés dans la mémoire 
de la carte avec la charte graphique et ne seront donc pris en compte qu‟après un reset de la carte 
suivant ce téléchargement. 

 
 
 
 
 

Chapitre 5 : Présentation générale de l’interface 
 
Une fois les paramètres configurés, cliquez sur « OK », pour valider les paramètres de votre nouveau 
projet. L‟interface principale du logiciel s‟affiche : 
 

 
 

1. Menu File 
 

Pour commencer un nouveau projet, ouvrir un fichier déjà existant ou sauvegarder votre projet en 
cours. 
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 New Project : Ouvre la fenêtre de paramétrage de votre nouveau projet, 

 Open Project : Ouvre un fichier projet existant, 

 Recents Projects : Liste des derniers fichiers projet enregistrés, 

 Save : Enregistre le projet, 

 Save As… : Enregistre le projet sous un nom de fichier différent, 

 Exit : Quitte l‟application GraphConverter 2.0. 
 

2. Menu Upload 
 

 
 

 Upload Graphic Library : Télécharge la charte graphique en cours (.hex) depuis votre 
ordinateur vers la mémoire de la carte. 

 Upload Firmware : Télécharge un firmware (.bin) depuis votre ordinateur vers la mémoire de 
la carte. 

 

3. Menu Tools 
Outils autours du projet en cours, de la carte cible et de l‟afficheur.  
 

 
 

 Project Parameters : Ouvre la fenêtre de configuration du projet en cours. 
 

 Test Card : Ouvre la fenêtre de test des différents paramètres de la carte cible et de la charte 
graphique chargée dans la carte (Consultez le chapitre « Chapitre 9 : Tester votre projet»). 

 

 Add New Driver : permet de sélectionner un nouveau fichier pilote (.lib) et le copier dans le 
dossier « LibraryCard ». 

 
 

4. Explorateur de projet 
 

Cette fenêtre vous permet de visualiser en un coup d‟œil le contenu complet de votre projet. 
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Vous pouvez ouvrir n‟importe quel « objet », police ou image, en cliquant sur son nom ou son numéro, 
la fenêtre d‟édition correspondante à l‟objet s‟affichera automatiquement.  

 

 
 
 
 
 

5. Barre d’états 
 

La barre d‟état affiche diverses informations sur le projet actif. 
 

 
 

 Memory Used : Affiche le pourcentage d‟octets qui sera utilisé dans la mémoire allouée par la 
carte graphique par le projet en cours (Une info-bulle sur la Progress Bar vous indique le 
nombre exact d‟octets que fait votre projet) 

 Materials Infos : Rappel du type de carte et d‟afficheur choisis pour le projet en cours. 
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Chapitre 6 : Edition des polices 
 
Cliquez sur l‟onglet “Fonts” de l‟éditeur. 
 

1. Présentation de l’onglet « Fonts » 
 

NB : Le nombre de polices que vous pouvez sélectionner dépend de la carte graphique. 
 

 
 

 Font Selector : 
 

 Family : Affiche l‟ensemble des polices installées sur votre ordinateur. C‟est dans ce 
tableau que vous sélectionnez la police à ajouter dans le projet (ex : Arial). 

 Style : Normal ou Italique, 

 Weight : Normal ou bold (Gras), 

 Size : taille de la police, 

 Interval : permet de régler le nombre de pixels entre deux caractères d‟un mot au 
moment de leur affichage. 

 

Font Selector : Sélection des polices et de leurs caractéristiques 

Family, Style, Weight, Size et Interval. 

Pré-visualisation de la police 
sélectionnée 

Explorateur du projet : Polices du 
projet. 

Bouton « Add selected 
Font » : Rajoute la police 
sélectionnée au projet 
courant. 

Onglet « Fonts » : Edition 
des Polices 

Police sélectionnée 
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 Preview : Permet de prévisualiser la police sélectionnée. Tapez un texte d‟exemple et 
visualisez-le dans le « Font Preview ». 

 

 Font Selected : affiche la police sélectionnée avec toutes ses caractéristiques 
(Ex : Arial, Italique, Bold, 12, 2). 

 

2. Ajouter une police   
 
1. Dans « Font Selector », sélectionnez le nom de la police souhaitée et ses différentes 

caractéristiques. 
2. Cliquez sur « Add Selected Font » : La nouvelle police apparaît dans l‟explorateur du projet 

avec le numéro 0. Son « Nom_Taille » apparaît dans le volet « Explorateur de projet » dans le 
style choisi (Normal, Gras, Italique…). La prochaine police prendra le numéro d‟appel suivant 
celui de la dernière police intégrée. 

 
NB : Le numéro précédant son nom correspondra à son numéro d’appel dans la fonction Escape Esc 
‘S’ ou GX_PutString(). 
 
Une info-bulle sur les polices du projet vous rappelle toutes les caractéristiques de cette police. 
 

 
 
 
NB : La jauge « Memory Used » met à jour le pourcentage de mémoire que prendra le projet après 
validation de cette police. 
 

5. Modifier une police 
 
Pour modifier une police du projet : 

1. Cliquez sur son numéro ou son nom dans l‟explorateur de projet. Un bouton s‟appelle 
« Modify Font N° (n° de la police) » apparait à côté de « Add Selected Font ».  

2. Cliquez dessus. La police du projet sera remplacée par la police sélectionnée dans l‟éditeur. 
 

 
 
 

6. Supprimer une police 
Pour supprimer une police de votre projet : 

1. cliquez sur son numéro ou son nom dans l‟explorateur de projet 
2. Appuyer sur la touche « Suppr » de votre clavier ou  
3. Clic droit souris →menu contextuel «Delete Font» 
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Chapitre 7 : Edition des images 
 
Cliquez sur l‟onglet “Pictures” de l‟éditeur. 
 

1. Présentation de l’onglet « Pictures »  
 

 
 

 Project’s pictures : Affiche sous forme d‟icônes réduits toutes les images intégrées dans le 
projet.  

 

Image sélectionnée et ses 
caractéristiques. 
  
 
 

Explorateur du projet : 
Images du projet 

Onglet « Pictures» : Edition 
des Images 

Zone images du projet 
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 Selected Picture : Affiche l‟image sélectionnée en taille réelle dans un cadre de résolution 
320x240 pixels. Permet de donner un aperçu de l‟image qui sera affichée sur votre écran 
LCD.  
NB : cette image est redimensionnée à l’affichage sur GraphConverter, sa taille ne correspond 
pas à l’originale qui sera téléchargée dans la mémoire de la carte graphique. 

 

 Caractéristiques de l’image sélectionnée : Affiche les dimensions réelles en pixels de 
l‟image. 

 

2. Ajouter une image 
Les images doivent être de type Windows ou OS2 bitmap non compressé, (*.bmp). La résolution 
maximale de ces images dépend de la zone affichable de votre LCD, (QVGA, VGA, ½ VGA) 
 

1. Cliquez sur le bouton « Add New Picture » de l‟éditeur. Une fenêtre standard d‟exploration 
de fichiers apparait. 

2. Sélectionnez le dossier dans lequel se trouve l‟image à ajouter, puis sélectionnez le fichier 
de l‟image,  

3. Cliquez sur “Ouvrir”. 
 
Le nom de l‟image apparaît dans l‟explorateur du projet avec le numéro 0. La prochaine image 
prendra le numéro d‟appel suivant celui de la dernière image intégrée du projet.  
 
NB : Dans l’explorateur de projet, le numéro précédant le nom de l’image correspond à son numéro 
d’appel dans la fonction Escape Esc ‘I’ ou GX_PutPicture(). 
 
Vous pouvez intégrer plusieurs images en une seule fois. Pour cela, il vous suffit de sélectionner 
plusieurs fichiers dans la fenêtre d‟ouverture de fichier. 
 
 
NB : La jauge « Memory Used » met à jour le pourcentage de mémoire que prendra le projet après 
validation de cette image. 
 

3. Insérer (au dessus) une image 
 

 
 

Pour insérer une image dans votre projet, cliquez sur le numéro ou le nom de l‟image qui sera placée 
à sa suite dans l‟explorateur de projet : clic droit souris et le menu contextuel « Insert Picture » 
apparait. Une fenêtre d‟exploration de fichiers apparait. Sélectionnez le dossier dans lequel se trouve 
l‟image à insérer, puis sélectionnez le fichier de l‟image, cliquez sur “Ouvrir”. L‟image est insérée au 
dessus de l‟image sélectionnée. Les numéros des images suivantes sont mis à jour. 
 

4. Modifier une image 
 

Pour modifier une image déjà enregistrée, cliquez sur son numéro ou son nom dans l‟explorateur de 
projet, puis clic droit souris → menu contextuel « Modify Picture ». Une fenêtre d‟exploration de 
fichiers apparait. Sélectionnez le dossier dans lequel se trouve l‟image de remplacement, puis 
sélectionnez le fichier de l‟image, cliquez sur “Ouvrir”. L‟image déjà enregistrée est remplacée par 
cette nouvelle image. 
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5. Supprimer une image 
 
Pour supprimer une image de votre projet, cliquez sur son numéro ou son nom dans l‟explorateur de 
projet : Key « Suppr » de votre clavier ou clic droit souris →menu contextuel « Delete Picture» 
apparait. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chapitre 8 : Enregistrer le projet 
 

Vous pouvez enregistrer un projet sous le même nom et dans le même dossier ou sous un autre nom 
ou dans un autre dossier.  

 
1. Enregistrer les modifications effectuées dans le projet actif 

 

1. Choisissez File→Save, 
2. Cliquez sur le bouton « Save » de l‟éditeur (uniquement activé à l‟ouverture d‟un 

nouveau projet ou si vous avez modifié votre projet en cours). 
 

 
 
A la sauvegarde, les données du projet sont automatiquement compilées et deux fichiers composant 
la charte sont générés : 
 

 Le fichier projet : NomduProjet.gxp,  

 Le fichier de données compilées : NomduProjet.hex. 
 

Ces fichiers projets sont sauvegardés dans un dossier portant le nom du projet dans le répertoire de 
votre projet. Dans ce dossier, un dossier « Pictures » sera créer afin d‟y copier toutes les images du 
projet et ce, quelque soit leurs emplacements d‟origine. 
 

 Un fichier header : « NomDuProjet.h (C/C ++) est également généré au moment de la 
compilation. Il contient les « #define » des polices et des images de votre projet courant. 
C‟est une nouvelle fonctionnalité de GraphConverter 2.0 qui vous fera gagner du temps à 
l‟implémentation du programme qui gèrera l‟affichage des données de votre IHM. 

 
 

2. Enregistrer le projet sous un autre nom ou dans un autre dossier  
 

1. Choisissez File→Save As... 
2. Entrez le nom du fichier et choisissez le dossier requis. 
3. Cliquez sur Enregistrer. 
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Chapitre 9 : Télécharger le projet  
 
Une charte de polices et d‟images destinée aux cartes graphiques CLAIRITEC est composée d‟un 
fichier projet (.gxp) et d‟un fichier binaire de données (.hex). Ce sont les données du fichier binaire qui 
sont téléchargées dans la carte graphique. 
 

1. Choisissez File→Upload Graphic Library   de la barre de menu ou 
2. Cliquez sur le bouton « Upload » de l‟éditeur  

 

 
 
La fenêtre de téléchargement « Upload Graphic Library » apparaît : 

 
 
 
Connectez la carte graphique sur le port USB avec le câble FTDI US232R. Le téléchargement de la 
charte graphique se fait via le port série Uart0 de la carte graphique. 
 
Cliquez sur le bouton « Upload» pour effectuer le transfert : La fenêtre de progression du 
téléchargement apparait. 
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 Transmission Speed : GraphConverter 2.0 interroge la carte pour déterminer la vitesse 
programmée et se synchronise dessus. Si la connexion s‟établie, l‟icône passe au vert. 

 
 
 
 
Le téléchargement du fichier se déroule en plusieurs étapes :  
 

1. Transfert du fichier dans la mémoire ram de la carte graphique. Une fois le transfert terminé, 
la carte graphique analyse le fichier et vérifie le checksum. 

2. Programmation de la mémoire flash. (Seuls les secteurs différents du fichier seront 
effectivement effacés et programmés avec les nouvelles données. 

3. Fin du téléchargement, la carte graphique vérifie la programmation, GraphConverter 2.0 
affiche un message de compte rendu et l‟image n°0 de votre nouvelle charte s‟affiche sur 
votre écran LCD. 

 
Chaque étape est indiquée en dessous de la barre de progression. Pendant le téléchargement, la 
carte graphique ne traite pas les commandes Escape. 
 
NB : Il est possible d’effectuer un téléchargement par votre application : il vous faut lire le fichier 
binaire (.Hex) et utiliser la commande Escape spéciale (Esc + ‘T’), décrite dans la note d’application 
« Fonction de programmation de la charte graphique GX_Update () ». Consultez la documentation de 
votre carte graphique pour plus de détails sur les commandes Escape et sur les caractéristiques de la 
mémoire interne allouée à votre charte. 
 
NB : Pour les cartes en mode CAN, le téléchargement de la charte se fait également via l‟interface 
série de la carte graphique. La procédure est identique à celle citée précédemment. 
 
Il est conseillé que votre application arrête d‟émettre les commandes CAN, car la carte graphique ne 
les traitera pas pendant le téléchargement. 
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Chapitre 10 : Tester votre projet 
 
Il vous est possible de voir immédiatement le rendu de vos polices et de vos images sur votre écran 
LCD avec le programme de test intégré dans GraphConverter 2.0. 
 

1. Cliquez sur Tools →Test Card ou 
2. Cliquez sur le bouton « Upload » de l‟éditeur.  

 

 
La fenêtre de « Test Card » apparait :  
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 Bouton Connexion : Connecte la carte et renvoie la vitesse de téléchargement chargée dans 
la carte.  

 

 Firmware version : Si la connexion s‟établit, la version « firmware » installée dans la carte 
s‟affiche. 

 

 Reset Card : Permet de réinitialiser la carte. (Si vous avez téléchargé une configuration de 
vitesse différente par rapport à celle du téléchargement, GraphConverter 2.0 resynchronisera 
automatiquement la vitesse de son port série.) 

 
 
 
 
 
 
 
 
 
 
 

 Test Fonts : Tapez le numéro de la police que vous souhaitez tester et cliquez sur « OK ». 
La fenêtre suivante s‟ouvre : 
 

 
 
Clic sur le bouton « OK » : la carte graphique reçoit la commande Escape „Esc‟ + „S‟avec le numéro 
de police que vous aurez sélectionné et le texte que vous aurez tapé.  
 
NB : Pour tester toutes vos polices, laissez 0 et faites « OK ». A chaque clic sur OK, le numéro de la 
police s’incrémente. 
 

 Test Pictures : Tapez le numéro de l‟image que vous souhaitez tester et cliquez sur « OK ». 
La fenêtre suivante s‟ouvre : 
 

 
 
Clic sur le bouton « OK » : La carte graphique reçoit la commande Escape „Esc‟ + „I‟ avec le numéro 
de l‟image que vous aurez sélectionné. A chaque clic sur OK, le numéro de l‟image s‟incrémente. 
 
NB : Pour tester toutes vos images, laissez 0 et faites « OK ». A chaque clic sur OK, le numéro de 
l’image s’incrémente. 
 
 

 Test Backlight: lance la commande Escape „Esc‟ + „k‟ avec la valeur affichée puis inverse sa 
valeur pour le 2ème appui. Ceci vous permet de déterminer le niveau actif du rétro-éclairage 

  

 Test Mire Touch : lance la commande Escape „Esc‟ + „m‟ qui lance le test de la mire tactile. 
Le bouton affiche alors « Reset » car pour sortir de la mire tactile, vous devez faire un 
« reset ». 
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Chapitre 11 : Maintenance Firmware 
 
GraphConverter 2.0 vous permet de maintenir le code firmware de vos cartes graphiques. 
 
Vous pouvez consulter la version logicielle du firmware embarqué et éventuellement le mettre à jour 
pour bénéficier des évolutions des commandes graphiques. 
 
Une fois le projet ouvert :  

1. Cliquez sur Upload→Upload Firmware. 
 

La fenêtre suivante s‟affiche : 
 

 
 
 
Pour mettre à jour le logiciel :  

1. Cliquez sur le bouton « Browse » pour chercher le fichier à télécharger fourni par CLAIRITEC 
2. Sélectionnez le fichier, (par exemple SG_v20.bin est le fichier firmware v2.0 de la carte 

graphique). Lorsque le fichier est reconnu par GraphConverter 2.0, la taille du code à 
télécharger s‟affiche sur la fenêtre ainsi que le nom du fichier sélectionné. 
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3. Cliquez sur le bouton « Upload » : GraphConverter 2.0 vous demande si vous voulez 
conserver la charte graphique déjà téléchargée dans la carte. Si vous répondez « Non », elle 
sera effacée et il vous faudra la télécharger de nouveau en cliquant sur « File Upload 
Graphic Library ». 

 
Le téléchargement du firmware démarre automatiquement, la vitesse de communication passe à 
530KBds pour le transfert du firmware. (Ceci ne modifiera pas les vitesses programmées dans la 
charte graphique), il s‟agit seulement de la vitesse gérée par le moniteur de mise à jour firmware. 
 

 
 

 
A la fin du téléchargement, GraphConverter 2.0 affiche un message de compte rendu. La carte 
graphique affiche l‟état de la mise à jour. 
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Chapitre 12 : Erreurs  
 

1. Les erreurs de communication 
 

 Error COM : CONFIG_FLASH : /Memory size : Vous téléchargez une charte graphique 
configurée pour une mémoire flash qui ne correspond à celle réellement implantée sur la carte 
graphique. 

 

 Error COM : SRAM_UPLOAD : Erreur pendant le téléchargement du fichier .hex dans la 
mémoire RAM de la carte graphique. 

 

 Error COM : FLASH_UPLOAD : Erreur pendant la programmation de la Flash. 
 

 Error COM : HEARTBEAT_ERASE : Perte de communication avec la carte graphique 
pendant la phase d‟effacement de la Flash de la carte graphique. 

 

 Error COM : HEARTBEAT_PROG : Perte de communication avec la carte graphique pendant 
la phase de programmation de la Flash de la carte graphique. 

 

 Error COM : Upload stopped by usé : Vous avez interrompu le transfert du fichier .hex vers la 
carte graphique. 

 

 Error COM : SYNCHROVITESSE : GraphConverter n‟arrive pas à se synchroniser avec la 
carte graphique. Généralement dû à un problème de connexion. 

 

 Error COM : TIMEOUT : Perte de communication avec la carte graphique. Généralement dû à 
un problème de connexion. 

 

 Error COM : BUFFER_OUT_FTDI_PLEIN : Le tampon mémoire du câble FTDI est saturé. 
Généralement dû à un problème de connexion. 

 

 Error COM : "FTDI : " + messageFTDIError ; Retour d‟erreur par le câble FTDI : 
 Liste des « messageFTDIError » 

 FTDI_INVALID_HANDLE : Perte du port USB: Déconnecter/reconnecter le câble 
FTDI et recommencer. 

 FTDI_DEVICE_NOT_FOUND: Le câble FTDI n‟est pas connecté. 
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 FTDI_DEVICE_NOT_OPENED: Le port USB du câle FTDI a été fermé par une autre 
application que GraphConverter.  

 FTDI_IO_ERROR: Perte du port USB: Déconnecter/reconnecter le câble FTDI et 
recommencer. 

 FTDI_INSUFFICIENT_RESOURCES : Problème de mémoire. 

 FTDI_OTHER_ERROR: erreur USB non connue: Déconnecter/reconnecter le câble 
FTDI et recommencer. 

 
2. Erreurs sur le fichier GXP 

 

 Error GXP : File missing : Fichier gxp déplacé ou effacé (Uniquement possible en choisissant 
un  Open Recents) 

 Error GXP : Erroneous datas in gxp file : Données du fichier erronées ; 2 possibilités :  

 Fichier gxp créé avec une version antérieure à GraphConverter 2.0 ou  

 Données modifiées manuellement. 
 

3. Erreurs sur les fichiers pilotes 
 

 Error GXP : Erroneous driver file : Données du fichier .lib erronées ; 2 possibilités :  

 Fichier .lib créé pour une version antérieure à GraphConverter 2.0 ou 

 Données modifiées manuellement. 

 Error GXP : Driver File missing : Fichier pilote absent dans le dossier LibraryCard 

 Error GXP : Driver missing : Référence de l‟afficheur LCD enregistré dans le fichier Gxp n‟est 
pas définie dans le fichier pilote. 

 Error GXP : Erroneous Numversion Lib : Version du fichier .lib incompatible 
 

4. Erreur sur les fichiers de polices ou d'images 
 
Error GXP : policeAbstente + Nom de la police 
Error GXP: File format doesn‟t comply POLICE NONCONFORME 
Error GXP: CodesStrBmp.BmpPath + " moved since last record: BIT_IMAGE_DEPLACEE 
Error GXP : CodesStrBmp.BmpPath + " missing : BIT_IMAGE_ABSENT 
 
 

Chapitre 13 : Support technique 
 

1. Support Technique  
 

 Eric Fourrier :  
 Tel : 05.56.973.973  
 Email : e.fourrier@clairitec.com 
 

2. Support Logiciel 
 

 Isabelle Vialard  
 Tel : 05.56.973.973 
 Email : i.vialard@clairitec.com  

 
 

Note pour les utilisateurs 

 
1. Tous les documents et pièces jointes à ce logiciel sont la propriété intellectuelle de 

CLAIRITEC. 
2. Il est interdit par la loi de décompiler, soumettre à ingénierie inverse, désassembler et de 

modifier de quelque manière que ce soit le format originel de ce logiciel. 
3. Il est illégal de modifier, adapter, louer, vendre ou traduire le logiciel, que ce soit en partie ou 

en entier. 

mailto:e.fourrier@clairitec.com
mailto:i.vialard@clairitec.com
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4. Vous pouvez installer une copie du logiciel sur un disque dur ou un périphérique de stockage 
similaire. 

5. Ce document reste la propriété exclusive de CLAIRITEC. Toute reproduction de ce document 
même partielle est formellement interdite sans accord écrit explicite de la part de CLAIRITEC. 


